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Chapter 512

One Proportion –
Superiority by a Margin
Tests
Introduction
This procedure computes confidence limits and superiority by a margin hypothesis tests for a single proportion.
For example, you might want confidence limits for the proportion of individuals with the common cold who took
ascorbic acid (vitamin C) and recovered within twenty-four hours. You might want to test the superiority
hypothesis that at least 70% of individuals with the common cold recovered immediately after taking ascorbic
acid when compared to a standard proportion of 55%.
Exact results, based on the binomial distribution, are calculated. Approximate results, based on the normal
approximation to the binomial distribution are also given. In the case of a single proportion, the exact results are
preferable to the approximate results and should always be used. The approximate results are available in the
software because they are commonly presented in elementary statistical texts.
This procedure accepts data entered as summary counts (number of “successes” and sample size), but can also
tabulate data from columns in the database.

The Binomial Model
Binomial data must exhibit the following four conditions:
1. The response can take on only one of two possible values. This is a binary response variable.
2. The response is observed a known number of times. Each replication is called a Bernoulli trial. The number
of replications is labeled n. The number of responses out of the n total that exhibit the outcome of interest is
labeled X. Thus X takes on the possible values 0, 1, 2, ..., n.
3. The probability that a particular outcome (a success) occurs is constant for each trial. This probability is
labeled P.
4. The trials are independent. The outcome of one trial does not influence the outcome of the any other trial.
The binomial probability, b(X; n, P), is calculated using:
𝑛𝑛
𝑏𝑏(𝑋𝑋; 𝑛𝑛, 𝑃𝑃) = � � 𝑃𝑃 𝑋𝑋 (1 − 𝑃𝑃)𝑛𝑛−𝑋𝑋
𝑋𝑋
where
𝑛𝑛!
𝑛𝑛
� �=
𝑋𝑋
𝑋𝑋! (𝑛𝑛 − 𝑋𝑋)!
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The estimate of P from a sample is labeled p and is estimated using:
𝑋𝑋
𝑝𝑝 =
𝑛𝑛

The label p̂ is often used in place of p in practice.

Confidence Limits
Using a mathematical relationship (see Ostle(1988), page 110) between the F distribution and the cumulative
binomial distribution, the lower and upper confidence limits of a 100 (1- α )% confidence interval are given by:

LCL =

XF[α / 2 ],[2 X , 2( n − X +1)]
( n − X + 1) + XF[α / 2 ],[2 X , 2( n − X +1)]

and

UCL =

( X + 1) F[1−α / 2],[2( X +1),2( n − X )]
( n − X ) + ( X + 1) F[1−α / 2],[2( X +1),2( n − X )]

Note that although these limits are based on direct calculation of the binomial distribution, they are only “exact”
for a few values of alpha. Otherwise, these limits are conservative (wider than necessary).
These limits may be approximated using the normal approximation to the binomial as
𝑝𝑝(1 − 𝑝𝑝)
𝑝𝑝 ± 𝑧𝑧𝛼𝛼⁄2 �
𝑛𝑛

If a correction for continuity is added, the above formula becomes

𝑝𝑝(1 − 𝑝𝑝) 1
𝑝𝑝 ± �𝑧𝑧𝛼𝛼⁄2 �
+ �
2𝑛𝑛
𝑛𝑛

Although these two approximate confidence intervals are found in many elementary statistics books, they are not
recommended in general. For example, Newcombe (1998) made a comparative study of seven confidence interval
techniques and these methods came in last.
Instead, Newcombe (1998) recommended the Wilson Score confidence interval method because of its
performance. The Wilson Score confidence interval is calculated using

(2np + z ) ± z z + 4np(1 − p )
2(n + z )
2

α /2

α /2

2

α /2

2

α /2

Superiority by a Margin Hypothesis Tests
Assume that lower proportions are worse, 𝑃𝑃 represents the population proportion of the response, S is a standard
reference proportion, and that M is the positive superiority margin. The null and alternative hypotheses are
H0: 𝑃𝑃 ≤ 𝑆𝑆 + 𝑀𝑀
H1: 𝑃𝑃 > 𝑆𝑆 + 𝑀𝑀

If, on the other hand, we assume that lower proportions are better, then null and alternative hypotheses are
H0: 𝑃𝑃 ≥ 𝑆𝑆 − 𝑀𝑀
H1: 𝑃𝑃 < 𝑆𝑆 − 𝑀𝑀

The superiority by a margin test compares the proportion to a non-zero quantity S – M or S + M. This test can also
be computed using the One Proportion procedure.
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The exact p-values for each of these situations may be computed as follows:
1. P (| ~
p − P |≥| p − P |) , where ~p represents all possible values of p. This probability is calculated using
0

0

the binomial distribution.
X

2.
3.

∑ b(r; n, p)
r=0
n

∑ b(r; n, p)

r= X

The simple large-sample z-test is based on the test statistic
𝑝𝑝 − 𝑃𝑃0
𝑧𝑧 =
�𝑃𝑃0 (1 − 𝑃𝑃0 )
𝑛𝑛
Two approximations to the exact p-values are also available. One uses 𝑃𝑃0 and the other uses p in the calculation of
the standard error. The first approximation uses 𝑃𝑃0 in the calculation of the standard error:
𝑋𝑋 + 0.5 − 𝑛𝑛𝑛𝑛0
𝑧𝑧𝑐𝑐 =
�𝑛𝑛𝑛𝑛0 (1 − 𝑃𝑃0 )
if 𝑋𝑋 < 𝑛𝑛𝑛𝑛0 , or
if 𝑋𝑋 > 𝑛𝑛𝑛𝑛0 .

𝑧𝑧𝑐𝑐 =

𝑋𝑋 − 0.5 − 𝑛𝑛𝑛𝑛0

�𝑛𝑛𝑛𝑛0 (1 − 𝑃𝑃0 )

The second approximation uses p in the calculation of the standard error:
𝑋𝑋 + 0.5 − 𝑛𝑛𝑛𝑛0
𝑧𝑧𝑐𝑐 =
�𝑛𝑛𝑛𝑛(1 − 𝑝𝑝)
if 𝑋𝑋 < 𝑛𝑛𝑛𝑛0 , or
if 𝑋𝑋 > 𝑛𝑛𝑛𝑛0 .

𝑧𝑧𝑐𝑐 =

𝑋𝑋 − 0.5 − 𝑛𝑛𝑛𝑛0
�𝑛𝑛𝑛𝑛(1 − 𝑝𝑝)

These z-values are used to calculate probabilities using the standard normal probability distribution.

Data Structure
The procedure accepts data entered as summary counts (number of “successes” (X) and sample size (n)), but can
also tabulate data from columns in the database. A separate report is generated for each outcome variable entered.
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Procedure Options
This section describes the options available in this procedure.

Data Tab
This panel specifies the variables or data that will be used in the analysis.
Type of Data Input
There are two formats that may be used to load the data into this procedure.
•

Enter the Number of “Successes” (X) and the Sample Size (n)
For this selection, you enter the number of “successes” (X) (items with the attribute of interest) and the total
sample size (n).

•

Tabulate “Successes” from a Categorical Outcome Variable in the Database
Use this option when you have raw data that must be tabulated. You will be asked to select a column in the
database that contains the categorical outcome values (such as “0” and “1” or “No” and “Yes”). The data in
the outcome variable will be read and summarized.

Summary Data
Number of “Successes” (X)
Enter the number of individuals in the sample for which the result was a “Success”. For a given scenario, a
“Success” might indicate “Attribute of Interest”, “Positive Response”, “Disease”, or something else. This value
must be a whole number between 0 and the Sample Size. Some of the formulas are unable to give meaningful
results if the Number of Success is equal to 0 or the sample size.
Sample Size (n)
Enter the number of individuals or experimental units in the sample. This number must be a whole number greater
than zero.

Database Input – Categorical Outcome Variable(s)
to be Tabulated
Outcome Variable(s)
Specify one or more categorical variables used to define the outcome or response. If more than one variable is
specified, a separate analysis is performed for each variable. This procedure analyzes only one outcome,
determined by the “Success” Value below.
“Success” Value
Specify the value in the output variable that is to be considered a “success” and tabulated. This is the value of
interest on which the proportions and analyses will be based. The entry is not case-sensitive.
Values and Value Labels
You may enter either the value or the value label (if specified) for the outcome of interest.
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Database Input – Frequency Variable
Frequency Variable
Specify an optional column containing the number of observations (cases) represented by each row. If this option
is left blank, each row of the dataset is assumed to represent one observation.

Database Input – Break Variables
Break Variable(s)
Enter up to 8 categorical break variables. The values in these variables are used to break the output up into
separate reports and plots. A separate set of reports is generated for each unique value (or unique combination of
values if multiple break variables are specified). The break variables will be applied in the order that they are
listed here.

Superiority by a Margin Test Options
Lower Proportions Are
This option defines whether lower proportions are to be considered better or worse. This choice determines the
direction of the superiority test.
•

Better
If lower proportions are better the null hypothesis is P ≥ (Standard Proportion) - (Superiority Margin) and the
alternative hypothesis is P < (Standard Proportion) - (Superiority Margin).

•

Worse
If lower proportions are worse the null hypothesis is P ≤ (Standard Proportion) + (Superiority Margin) and the
alternative hypothesis is P > (Standard Proportion) + (Superiority Margin).

Standard Proportion
This is the known standard or reference proportion against which the sample proportion will be compared.
Superiority Margin
Enter the desired value of the superiority margin. This value should be positive. (The correct sign will be applied
when the null and alternative hypotheses are created based on the selection for “Lower Proportions Are”.)

Reports Tab
This panel specifies the reports to be produced in the analysis.

Data Report
Data Report
Check this box to obtain a summary of the data entered, as well as the sample proportion.
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Confidence Intervals
Confidence Level
This confidence level is used for all the confidence interval reports of this procedure. Typical confidence levels
are 90%, 95%, and 99%, with 95% being the most common.
Confidence Interval Report
Check each box to obtain the corresponding confidence interval report.The details and formulas for each report
are given in the documentation above.

Tests
Alpha
Enter the value of alpha to be used for all hypothesis tests in this procedure. The probability level (p-value) is
compared to alpha to determine whether to reject the null hypothesis.

Report Options Tab
The following options control the format of the reports.

Report Options
Variable Names
Specify whether to use variable names, variable labels, or both to label output reports. In this discussion, the
variables are the columns of the data table.
•

Names
Variable names are the column headings that appear on the data table. They may be modified by clicking the
Column Info button on the Data window or by clicking the right mouse button while the mouse is pointing to
the column heading.

•

Labels
This refers to the optional labels that may be specified for each column. Clicking the Column Info button on
the Data window allows you to enter them.

•

Both
Both the variable names and labels are displayed.

Comments
1. Most reports are formatted to receive about 12 characters for variable names.
2. Variable Names cannot contain blanks or math symbols (like + - * / . ,), but variable labels can.
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Value Labels
Value Labels are used to make reports more legible by assigning meaningful labels to numbers and codes.
The options are
•

Data Values
All data are displayed in their original format, regardless of whether a value label has been set or not.

•

Value Labels
All values of variables that have a value label variable designated are converted to their corresponding value
label when they are output. This does not modify their value during computation.

•

Both
Both data value and value label are displayed.

Example
A variable named GENDER (used as a grouping variable) contains 1’s and 2’s. By specifying a value label for
GENDER, the report can display “Male” instead of 1 and “Female” instead of 2. This option specifies whether
(and how) to use the value labels.

Decimal Places
Item Decimal Places
These decimal options allow the user to specify the number of decimal places for items in the output. Your choice
here will not affect calculations; it will only affect the format of the output.
Auto
If one of the “Auto” options is selected, the ending zero digits are not shown. For example, if “Auto (0 to 7)” is
chosen,
0.0500 is displayed as 0.05
1.314583689 is displayed as 1.314584
The output formatting system is not designed to accommodate “Auto (0 to 13)”, and if chosen, this will likely lead
to lines that run on to a second line. This option is included, however, for the rare case when a very large number
of decimals is needed.
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Example 1 – Superiority by a Margin Test of One Proportion using
Summary Data
This section presents an example of how to run a superiority by a margin test of summary data in which n is 100,
X is 55, the standard proportion, S, is 0.40, and the superiority margin, M, is set to 0.05.
You may follow along here by making the appropriate entries or load the completed template Example 1 by
clicking on Open Example Template from the File menu of the One Proportion - Superiority by a Margin Tests
window.
1

Open the One Proportion - Superiority by a Margin Tests window.
•
Using the Analysis menu or the Procedure Navigator, find and select the One Proportion - Superiority
by a Margin Tests procedure.
•
On the menus, select File, then New Template. This will fill the procedure with the default template.

2

Specify the data and test.
•
Select the Data tab.
•
For Type of Data Input select Enter the Number of “Successes” (X) and the Sample Size (n).
•
In the Number of “Successes” (X) box, enter 55.
•
In the Sample Size (n) box, enter 100.
•
For Lower Proportions Are select Worse.
•
For Standard Proportion enter 0.40.
•
For Superiority Margin enter 0.05.

3

Specify the reports.
•
Select the Reports tab.
•
Check all confidence interval reports.
•
Check all tests.

4

Run the procedure.
•
From the Run menu, select Run Procedure. Alternatively, just click the green Run button.

Data Report
Data Report
Number of
"Successes" (X)
55

Sample
Size (n)
100

Sample
Proportion (p)
0.55

This report documents the values that were entered.

Confidence Limits Section
Exact Confidence Interval of P
Number of
"Successes" (X)
55

Sample
Size (n)
100

Sample
Proportion (p)
0.55

Z*
1.95996

95% C. I. of P
Lower
Upper
Limit
Limit
0.4472802 0.6496798
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Simple Z Confidence Interval of P
Number of
"Successes" (X)
55

Sample
Size (n)
100

Sample
Proportion (p)
0.55

Z*
1.95996

95% C. I. of P
Lower
Upper
Limit
Limit
0.452493 0.647507

Simple Z Confidence Interval of P with Continuity Correction
Number of
"Successes" (X)
55

Sample
Size (n)
100

Sample
Proportion (p)
0.55

Z*
1.95996

95% C. I. of P
Lower
Upper
Limit
Limit
0.447493 0.6525069

Z*
1.95996

95% C. I. of P
Lower
Upper
Limit
Limit
0.452446 0.6438546

Wilson Score Confidence Interval of P
Number of
"Successes" (X)
55

Sample
Size (n)
100

Sample
Proportion (p)
0.55

The Wilson score interval is the interval recommended in Newcombe (1998). The limits are based on the
formulas that were presented earlier.

Hypothesis Test Section
Exact Test for Superiority by a Margin
Lower Proportions are Worse
Superiority Hypothesis: P > 0.4 + 0.05
Alternative
Hypothesis
Ha: P > 0.45

Sample
Proportion
0.55

Prob
Level
0.02839

Conclude
Superiority
at α = 0.05?
Yes

Simple Z-Test for Superiority by a Margin
Lower Proportions are Worse
Superiority Hypothesis: P > 0.4 + 0.05
Alternative
Hypothesis
Ha: P > 0.45

Sample
Proportion
0.55

Z-Statistic
2.01010

Prob
Level
0.02221

Conclude
Superiority
at α = 0.05?
Yes

Z Approximation Test using P0 for Superiority by a Margin
Lower Proportions are Worse
Superiority Hypothesis: P > 0.4 + 0.05
Alternative
Hypothesis
Ha: P > 0.45

Sample
Proportion
0.55

Z-Statistic
1.90960

Prob
Level
0.02809

Conclude
Superiority
at α = 0.05?
Yes

Z Approximation Test using p for Superiority by a Margin
Lower Proportions are Worse
Superiority Hypothesis: P > 0.4 + 0.05
Alternative
Hypothesis
Ha: P > 0.45

Sample
Proportion
0.55

Z-Statistic
1.90960

Prob
Level
0.02809

Conclude
Superiority
at α = 0.05?
Yes

The formulas for these tests were shown earlier.
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Example 2 – Superiority by a Margin Test of One Proportion using
Raw Data
This section presents an example of how to run an analysis of raw data that may have been used to generate the
summary data in example 1. The data for this example are found in the Prop1 dataset.
You may follow along here by making the appropriate entries or load the completed template Example 2 by
clicking on Open Example Template from the File menu of the One Proportion - Superiority by a Margin Tests
window.
1

Open the Prop1 dataset.
•
From the File menu of the NCSS Data window, select Open Example Data.
•
Click on the file Prop1.NCSS.
•
Click Open.

2

Open the One Proportion - Superiority by a Margin Tests window.
•
Using the Analysis menu or the Procedure Navigator, find and select the One Proportion - Superiority
by a Margin Tests procedure.
•
On the menus, select File, then New Template. This will fill the procedure with the default template.

3

Specify the variables.
•
Select the Data tab.
•
For Type of Data Input select Tabulate “Successes” from a Categorical Outcome Variable in the
Database.
•
Double-click in the Outcome Variable(s) text box. This will bring up the variable selection window.
•
Select Response from the list of variables and then click Ok. “Response” will appear in the Outcome
Variable(s) box.
•
For “Success” Value, enter 1. (Alternatively, since this dataset contains value labels, you could enter Yes
for “Success” Value since the label for a value of 1 is “Yes”. See settings template Example 2b.)
•
For Lower Proportions Are select Worse.
•
For Standard Proportion enter 0.40.
•
For Superiority Margin enter 0.05.

4

Specify the reports.
•
Select the Reports tab.
•
Check all confidence interval reports.
•
Check all tests.

5

Run the procedure.
•
From the Run menu, select Run Procedure. Alternatively, just click the green Run button.

Output
Data Report for Response
Number of
"Successes" (X)
55

Sample
Size (n)
100

Sample
Proportion (p)
0.55

(Report continues with results exactly as in Example 1)

The results are exactly the same as they were in example 1.
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